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Factotum for Word™ is an add-in environment for Microsoft Word 6 for Windows™ that is designed for students,
teachers, researchers and note takers of all descriptions.

A 15 page manual follows and can be printed or viewed on-screen.

Factotum for Word is ideal for documents that are both built up and used over time.

Microsoft Word 6 for Windows is the world’s best word processor,
Factotum for Word turns it into a dedicated information processor.

Its job is to take the hard work out of the entry, formatting,
navigating, structuring, ordering, retrieval and reporting of
information.

In other words Microsoft nearly pulled it off, but Factotum for Word
really does give you “Information at your fingertips” (sorry Bill).

All trademarks etc acknowledged

Factotum for Word is not just a collection of Word macros. Instead it is a combination of:

1. Unique double-screen working environment with constant, interactive on-screen table of
contents for easy navigation and organisation

2. Over 50 dedicated information processing commands accessed through toolbars and
easy-to-remember keyboard shortcuts

3. 15 comprehensive in-built paragraph and text styles representing all the features most
commonly found in notes (headings, quotes, key figures, key terms etc)

These elements work together to give you a completely new approach
to the whole note taking process.
Factotum for Word helps keep you in control whether you are entering, organising or retrieving your information.

Dedication: For Jane (and her PhD)

Version 1.1 of Factotum for Word is designed for evaluation purposes only and if you use the program you must
register / upgrade. This costs £25.00 or $40.00 (inc. VAT) and offers improved documentation, performance,
integration, functionality and the ability to customise both Factotum for Word and the files that it produces.
Genuine full time students are eligible for a £10 or $15 discount if they enclose a copy of their current matriculation
card.

The liability for running Factotum lies entirely with the user.

© 1995 Online Design, Greenside House, 25 Greenside Place, Edinburgh, UK, EH1 3AA
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TERMS / CONDITIONS
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This version of Factotum for Word is available for
downloading without charge. However if you use the
program you must register/upgrade (see below).

Factotum for Word will perform in substantial
compliance with this documentation. However the
liability for running the program lies entirely with the
user at all times.

You may copy and distribute this evaluation version
of Factotum for Word freely provided that a) no fee is
charged (excluding a reasonable disk copying
charge) and b) it is only distributed in its original
unmodified state. You may not use this program in a
commercial or governmental environment without
registering / upgrading. Site licences and commercial
distribution licences are negotiable.

Running the program is taken as agreement to these
terms.

REGISTRATION /
UPGRADING

Version 1.1 is fully functional and is designed to
allow you to evaluate whether Factotum for Word
would help you in your work. There are some in-built
limitations, in particular the inability to customise
either the Factotum for Word template (for example
you cannot set your own default headers and
footers) or the files that you produce with it (for
example you cannot change the default typeface
from Avrial).

Registration / upgrading costs £25.00 or $40.00 inc.
VAT and offers:

1. Improved Documentation (including separate
manuals, sample files etc)

2. Better Performance (some functions are up to a
100% faster, no nag screens, footers etc)

3. Improved Functionality (the most common
note taking commands available through a
special Writing Aids toolbar)

4. Better Integration (open Factotum and non-
Factotum files simultaneously with full
toolbars etc)

5. Customisability (the abilty to format the
Factotum for Word template and the files
that you create with it — no limitation to Arial)

6. Better Health (sleep easy at night knowing you
are supporting Factotum for Word’s ongoing
development)

Genuine full time students are eligible for a discount
of £10 or $15 if they include a photocopy of their
current matriculation card.
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WHAT FACTOTUM DOES

The Note Taking Problem

The problem with word processors, even those as
powerful as Word, is that they encourage a very
simple and linear approach. Their main aim is always
to take you as efficiently as possible through from
beginning to end, from “Dear Sir” through to “Yours
sincerely” and the final printout. Unfortunately as
note takers soon find out all the three main stages of
note taking — information entry, organisation and
retrieval — are anything but straightforward.

INFORMATION ENTRY: In terms of text entry,
different pieces of information come over time from
multiple sources. For example you might be taking
notes on Jung but if you have an inspired thought
about Freud you need to easily be able to go to the
relevant section before it's forgotten. In this way your
notes are not so much written as built up in a non
sequential way over time. To be useful, all sections
of your notes must be easily accessible at all times.

INFORMATION ORGANISATION: Moreover as
more information is added you will almost certainly
find that you want to restructure it. For example as
you learn more about Freud you might well decide
that your notes on his thinking would be better split
into sections for his early and late theories. The
structure of your notes must be able to be changed
easily. Notes might be built up but they must remain
completely fluid at all times.

INFORMATION RETRIEVAL: Finally it is important
to realise that information only becomes useful when
it is retrieved. The notes you take today will probably
not be used until you produce an essay weeks later
or until you revise them maybe in a year’s time.
What’'s more, when you do come to retrieve your
information, not all of it will be useful to the job in
hand. For example if you are producing an article on
Freud’s views on women, your notes on Jung are
irrelevant. When you return to your notes you must
still feel that you are in control and that the relevant
information they contain is easily retrievable at all
times.

Overall, note taking is something of a special case,
primarily needing the free style capabilities of word-
processing, but also benefiting from some database
style functions (quick access, searching, reordering,
retrieval etc). Unfortunately note takers tend to fall
through this gap that exists between word
processors and databases. Even when they have
access to a computer, they normally take notes on
paper and then, if they are slightly more organised,
reorder them onto cards and then, insult to injury,
rough them out as essay plans onto paper again.
Only when they are writing the finished report do
they finally turn to the computer. Hardly efficient and
surely not the best that the information revolution has
to offer.
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The Factotum Solution

This is where Factotum for Word comes in. It doesn’t
just offer some otherwise missing commands, but a
completely new approach to the whole note taking
process that turns Word from a word processor into
an Information Processor. Instead of the linear
approach it tries to help you keep in control of all
your notes at all times whether you are entering,
organising or retrieving your information.

So how does Factotum work in practice? Essentially
it's a combination of new working environment and
new functionality. The most obvious difference in the
Factotum interface is the double window view of
each document. The window on the right is the
normal Word window for entering text, the window on
the left is an on-screen table of contents of this same
document, acting as a constant overview of the
structure of your information and, as we’ll see later, a
device to help navigation and reorganisation.

Working with the double window environment are a
series of commands available from the special
Factotum toolbars. All the power of Word is available
just as before, but in addition with one click of the
mouse you can access new commands that help in
all three parts of the note taking process:

Entering Information

1. MARK & FORMAT the most common document
features such as quotes, key terms, books
etc.

2. STRUCTURE your notes automatically with four
in-built levels of heading.

3. NAVIGATE through the sections of your
notes with an interactive on-screen table of
contents.

Organising Information
1. CUT, COPY & PASTE easily within and between

documents with special split document
views.

2. COLLECT relevant text together from throughout
your notes.

3. RESTRUCTURE the sections of your notes
interactively.

Retrieving Information

"Hereafter called “Factotum”
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1. MOVE instantly to the next/previous heading, or
tag (such as a quote or keyword), or
instance of the current word.

2. SEARCH for any previously marked feature
(such as list items, key figures, quotes
containing the word “love” etc.)

3. EXPORT text from your notes (for example
to create a crib or handout file only
containing headings and quotes, or to create
an essay base file containing all information
relevant to it.)

Tip: To get a better idea of what Factotum does and how it
works read the In Practice section at the end of this file.

SETTING UP FACTOTUM

Factotum for Word' only works with version 6
(and above?) of Microsoft Word for Windows.

Installing Factotum

The Factotum program and manual are both
contained within a single file, a Word template file
called FACTO1.DOT. It is the text contained within
this file that you are reading now.

To be able to create your own Factotum files you
need to install this file into the default Word template
directory (normally C:\WINWORD\TEMPLATE).

If you've loaded this file (FACTO1.DOT) in Word you
are already running Factotum (you’ll be able to tell by
the double-screen environment and the different
arrangement of toolbars). In future you can load the
file either with the Open command under the File
menu — after changing the File Type to “Document
Templates *.dot” — or most easily by double-clicking
on the FACTO1.DOT file under File Manager. You
should print out this manual for reference.

Tip: If Factotum is not installed correctly it will warn you
when you open the Facto1.dot file and inform you which
directory you should copy it to.

Running Factotum / Creating
Files

So how do you run Factotum in future, once it has
been installed?

Because Factotum runs from within Word you do not
need a separate icon in Program Manager to load
the program. Instead the program is loaded each
time you open a Word document that is based on the
Facto1.dot template.

There are two ways create a new Factotum file and
so to load the Factotum environment:

1. To create a new Factotum file from a basic Word
session, select the New command from the
File menu and select “Facto1” from the list of
templates to base it on.
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2. To create a new Factotum file when the
Factotum environment is already running
you can simply click on the New command in
the Factotum toolbar.

A “Factotum file” is a perfectly normal Word
document but, because it is based on the Factotum
template (facto1.dot), it also has the added
functionality of the Factotum interface. All the normal
Word menu commands for opening, saving, printing,
spell-checking, footnoting etc are used just as you
would expect.

General Information

Learning Factotum / Getting Help

If you are still unsure of how Factotum for Word
could help you, read through the In Practice section
towards the end of this manual. Otherwise, the best
way of getting to grips with the program is to print out
this manual and then run through each of the toolbar
commands as they are covered below.

This combined program/documentation single file
version of Factotum has no separate help file.
Instead you can gain access to this manual from any
Factotum file you have created with the Factotum
Help command under the Help menu.

Tip: The keyboard shortcut for calling up Factotum Help is
Alt + Ctrl + H.

Word’s Tooltips feature means that holding the
cursor over a command button reveals its name and
a short description of what it does in the status bar at
the bottom of the screen.

In use, all of Factotum for Word’s power is in addition
to Word’'s — all the normal menu commands are
available just as before. However if at any time you
would feel more comfortable working in the basic
Word setup with normal toolbars, scroll bars etc, this
can be done with the Environment Toggle command
under the View menu.

Tip: The keyboard shortcut for the Environment Toggle
command is Alt + Ctrl + End.

Working with Other Files / Converting

If you open both Factotum files and other files
simultaneously, the normal Standard and Formatting
toolbars will not initially be available for your non
Factotum files (unless you use the Environment
Toggle command to return to a basic Word
environment). For seamless integration of Factotum
and non Factotum files you must register / upgrade.

The easiest way to convert previously created files to
Factotum files is to apply the Facto1.dot template
with the Attach option under the Templates
command under the File menu, then close the file
and reopen it.

Removing Factotum

You lose nothing when you work with Factotum for
Word, however if you decide that you do not need
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the extra functionality it provides you can remove the
program by simply deleting the Facto1.dot file from
the Word template directory.

To remove the Factotum environment from a
previously created Factotum file, attach a different
template with the Template command under the File
menu. Close the file and reopen it.

FACTOTUM’S INTERFACE

As described earlier Factotum offers a totally new
approach to the whole business of taking notes. This
new approach and power comes at no cost; when
you are working within the Factotum environment all
the capabilites of Word remain. All the usual
commands are available from the menus just as
expected. You lose nothing but you also have the
benefit of a new working environment customised for
the job of building up notes. This consists of a double
screen arrangement explained below together with a
series of toolbars giving access to commands
specifically tailored to note taking.

Wir el |
Ci= Liit Y¥en Jevzt Twwal Jud:  Tabk  Howen  lrep

1" L5000 1 - LAl 141 b 14 L e e
| 3 7 I = s o S [P L
Cacumanci:e

= Factotum Toolbar

Tagging Toolbar

4

QUTLINE
WINDOW

EDITING
WINDOW

C-[= G O]

Outlining] Toolbar

Text Format Toolhar
= |~ o ] i EY N Y N E S S TR T S [ EE [

g1 e ] r A [ TR N TR R X T

There are different arrangements of toolbars and
command buttons explained below but the first thing
you’ll notice about the Factotum screen compared to
the basic Word set-up is that whenever you load a
Factotum file two windows automatically open. Each
window is a different view of the same document.

The one to the right is the EDITING WINDOW, marked
with the extension “:2” in its title bar. The one to the
left is the OUTLINE WINDOW, marked with the
extension “1” in its title bar. Each window is
activated by clicking in it with the mouse.

Tip: The keyboard shortcut for swapping between Outline
and Editing Windows and vice versa is Alt + Ctrl + Home.

The Editing Window

The Editing Window is the normal Word window
where notes are input and edited and reviewed.
Under Factotum it is also used for quickly “tagging”
and formatting different document features.

Because of the presence of the Outline Window the
area is smaller than in a normal Word session. If you
prefer a larger work area you can maximize the
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window, but in fact the shorter line lengths are better
suited for on-screen reading in any case.

As a safety blanket device there is also the option of
using the Factotum Toolbar's Environment Toggle
command to temporarily restore a basic Word
environment with full screen, scroll bars and the
default toolbars. Hopefully you won'’t use it, but it is
there to emphasise that you lose nothing while
working under Factotum and means that you have
no excuse for not experimenting with its power.

The Outline Window

The Outline Window should be seen as an
interactive on-screen table of contents, a constant
reminder of the structure of your document and an
invaluable navigational and organisational tool.
When the Outline Window is selected the Outlining
Toolbar is activated giving access to its various
commands.

The most common use of the Outline Window and its
toolbar is to navigate through the table of contents
and instantly call up the relevant section of notes in
the Editing Window for reviewing or amending. In
addition there are commands for interactively
restructuring and reordering your notes and for
marking sections for exporting.

Tip: As there is limited screen space the Outline Window
does not have a scroll bar. To move through an extensive
outline use the various cursor keys, PgUp/Dn, Ctrl +
Home/End efc. Alternatively drag with your mouse to move
in either direction and then release when you are in the
section you want.

The Factotum Toolbars

All the familiar Word menus and commands are left
untouched and working just as you would expect
them to. Instead, the power of Factotum is accessed
through its toolbars or, as you get more used to the
program, through its extensive and easily
remembered keyboard shortcuts.

There are three main Factotum toolbars
1. Factotum Toolbar (under the Menu bar)

2. Tagging Toolbar (under the Factotum Toolbar)

3. Outlining Toolbar (positioned vertically
when the Outline Window is activated)

These are explained in their own sections below.

In addition there is the TEXT FORMAT TOOLBAR
positioned at the bottom of the Factotum screen (as
text formatting is not as important to note taking as to
normal word processing). The commands are those
that are found on the normal Word toolbars and
control the number of columns, tables, typeface,
pointsize, text style, bullets and numbering, indents,
alignment and borders. All these commands work as
usual and are not discussed further here.

Although you can change typefaces and style
formats in a given session these will be restored to
their defaults when you next open your file. If you
want to be able to customise your files permanently
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(in particular to avoid the limitation to Arial) you
should upgrade.

THE TAGGING TOOLBAR

The TAGGING TOOLBAR (or Formatting toolbar) is the
second horizontal toolbar under the menu bar.
Rather than the normal Word formatting toolbar
which is concerned with the appearance of your text,
Factotum’s Tagging Toolbar is concerned more with
the internal structure of your notes.

Tagging your notes is the process whereby, with
one click on the commands on the Tagging Toolbar,
you mark paragraphs and text within paragraphs as
document features. Factotum comes with 15 in-built
tags (each a Word style) representing all the features
that most frequently occur in typical notes (headings,
quotes, key figures, books etc.)

Tagging helps in all the three main areas of note
taking; entry, ordering and retrieval of information:

1. Using the heading tags gives your notes an
automatic structure. This is shown in the
Outline Window acting as a constant
reminder of the organisation of your notes
and is used for easy navigating and
reordering.

2. Tagging provides instant formatting so that, for
example, a quote tag is automatically
indented from both margins and italicised.

3. Tagging helps future information retrieval
by allowing a document to be searched by its
features. It is easy, for example, to move
through a document from one key figure to
another or to search for all list items with the
word “television” in them or to create a
handout file only containing headings and
quotes.

Tagging

There are three types of Tag:

1. Heading Tags (marking the titles of the sections
of your notes)

2. Paragraph Tags (marking other document
features on a paragraph basis eg quotes,
lists)

3. Text Tags (marking document features
within paragraphs eg key terms, book titles)

Heading and paragraph tags can be applied to the
current paragraph(s) using the numbered tags 1-9.
Multiple consecutive paragraphs can be tagged
simultaneously in the Editing Window (eg List Items),
but only one paragraph can be tagged at a time in
the Outline Window.

Text tags are applied to the current selection or word
with the Text Tags A-E. As you type, selecting the
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tag switches on tagging until you turn it off by
selecting the Normal Text Tag (Z) command.

The current tag is indicated in the TAG DROP DOWN
LisT, the first item on the Tagging Toolbar. Text tags
take precedence so a book within a list item will be
shown as a book.

Heading Tags

The HEADING TAGS 1-4 are Word’s in-built heading
levels 1-4. They are used for structuring your notes
in a hierarchy of importance. Applying one of these
tags to a paragraph will automatically update the
Outline Window’s on-screen table of contents. The
headings can then be used for easy navigation and
restructuring of your notes.

The four heading tags are hierarchical headings of
decreasing importance (and are automatically
formatted as such, emboldened and coloured)

1  Heading Tag1 MAJOR DivisiON

Used as the title of fundamental sections of notes

Z  Heading Tag2 MAJOR SECTION

Used as the title of the second most important
sections of your notes

= Heading Tag 3 SECTION

Used as the heading to a section of notes

4 Heading Tag4 SuB SECTION
Used as the lowest level of heading for your notes

Word’s other in-built heading levels 5-9 can be
applied, but will not automatically appear in the
Outline Window and cannot be searched for with the
Search dialog.

Tip: The keyboard shortcuts for the Heading Tag
commands 1-4 are Alt + Ctrl + 1, 2, 3 or 4.
Paragraph Tags

The PARAGRAPH TAGS 5-9 are used to mark up
document features that regularly occur in typical
notes such as quotes and lists.

The suggested use and in-built formatting of the

paragraph tags 5t0 9 is
S ParaTag5 NoTA BENE

Used for any paragraphs you want to stress,
summaries etc (marked with a margin bar)

& Para Tag 6 QuOTE

Used for quotes and direct lifts (indented and
italicised)

7/  ParaTag7
Used for lists of items (numbered, left aligned)

& ParaTag8

LisT ITEM

STANDALONE

Factotum 1.1 for Microsoft Word 6 (Unregistered)

Used for any other features that consistently stand
by themselves eg facts or descriptions (emboldened
and italicised)

¥  ParaTag9 MEmoO

Used for more personal use: your own ideas and
reminders to yourself (italicised and coloured)

Each paragraph can only have one paragraph tag at
a time so selecting a new paragraph tag removes
any previously applied. To remove all paragraph tags
click on

0 Para Tag 0 NORMAL PARAGRAPH
Used to return a paragraph to the Normal style.

Tip: The keyboard shortcuts for applying the Paragraph
Tag commands are Alt + Ctrl + 5, 6, 7, 8, 9 with Alt + Ctrl +
0 used for returning any paragraph to normal.

Text Tags

The five TEXT TAGS A-E can be applied to document
features such as names, publications, dates etc
within paragraphs (whether tagged or not). Clicking
on the A to E Text Tag commands marks and
automatically formats the current selection or word
with the respective text tag. As you type, selecting
the tag switches on tagging until you turn it off by
selecting the Normal Text Tag command.

The text tags are used to consistently format
features such as publication references and also for
information retrieval as they can easily be searched
for. With text tags it is easy, for example, to move
through your notes from one key figure or term to the
next or to find all publications containing “1988”.

They are intended to mark important instances of
who, where, what, when, how and why in your notes.
The suggested use and automatic formatting is

M TextTagA AGENT (who)

Used for agents ie any key figures, authors etc in
your notes (emboldened and coloured)

E Text TagB BooOK (where)

Used for books, key publications or other references
(italicised, underlined and coloured)

C  TextTagC CONCEPT (what)

Used for concepts and key terms (emboldened,
small caps and coloured)

[ TextTagD DATE (when)

Used for key dates (italicised and coloured)

E TextTagE ExampLE  (how/why)
Used for examples, explanations, definitions etc
(coloured)

Each text selection can only have one text tag (and
one paragraph tag) at a time so selecting a new text
tag removes any previously applied. To remove all
text tags from a selection click on

Z  TextTagZ NORMAL TEXT
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Used to remove all text tags and to return the current
selection to normal text.

Tip: The keyboard shortcuts for the Text Tag commands
are Alt + Ctrl + A, B, C, D, and E with Alt + Ctrl + Z used
for removing any text tags and returning the text to
Normal.

Customising Tags

In fact although these suggested uses for tags have
been specifically designed to meet most needs you
can use the tags for whatever features you want in
your document. For example in this file the memo
paragraph tag has been used for marking tips and
the concept text tag for marking commands.

However in this version of Factotum you cannot
change the formatting of the tags. If you select the
Style or Style Gallery commands from the Format
menu you will be warned that although you can
make changes for the current session, next time you
load your file the in-built defaults will override any
changes you have made. In addition, although you
can change typeface formatting directly for any text
during the current session, this will automatically
return to the default next time you load the file. In
practice this means that you are limited to using Arial
as the typeface for your Factotum files.

If you need to be able to customise Factotum or the
files you produce with it you must upgrade.

Marking

Marking is another form of tagging paragraphs that is
useful for two main purposes. Firstly it is used for
bringing together separate paragraphs from
throughout a document into a new section if you
decide that that makes more sense for your notes.
Secondly it is used for marking relevant sections and
paragraphs to be exported into a new document
either as the basis for creating an essay or as a crib
or handout file (for example only containing headings
and quotes).

These processes are covered under the Collect
Marked and Mark and Export commands and also in
the In Practice sections below.

To mark a paragraph or section use the M Mark
command. To remove marking from a paragraph or
section use the ! UNMARK command. Paragraphs
are only meant to be marked temporarily and are
indicated by overscoring.

In the Editing Window marking works on a paragraph
basis so that sections within a paragraph cannot be
marked separately. In the Outline Window marking
works on a section basis so that all text between the
current heading tag and the next visible heading tag
is automatically marked or unmarked. This effect is
controlled with the depth of view commands of the
Outlining Toolbar. To remove all marking select the
entire document with the command under the Edit
menu and then click on the Unmark command.

Factotum 1.1 for Microsoft Word 6 (Unregistered)

Tip: The keyboard shortcuts for the Mark and Unmark
commands are Alt + Ctrl + M and Alt + Ctrl + U.

THE FACTOTUM TOOLBAR

Below the menu bar is the FACTOTUM TOOLBAR (or
Standard toolbar). This is used for file management,
editing, moving, searching, controlling marked text,
arranging windows and changing the view of your
document.

File Management

As in a normal word session there are the
commands for [J New, i open, [ Save. Clicking
on the New command from an existing Factotum file
is the easiest way of creating a new Factotum file. If
you Open a non Factotum file its toolbars will not be
visible (unless you use the Environment Toggle
command). For seamless integration of Factotum
and non Factotum files you must upgrade / register.

Tip: The keyboard shortcuts for New, Open, and Save are
the normal Word shortcuts Ctrl + N, Ctrl + O, Ctrl + S.

The & QuIT FILE command closes both windows of
the current file. The &8 PRINT command calls up the
print dialog box. The print output depends on
whether you select print from the Outline or Editing
Window. The (4 CopPY To FLOPPY copies the current
file to drive a: for easy backup.

Tip: The keyboard shortcuts for the Quit File and Copy to
Floppy commands are Alt + Ctrl + Q and Alt + Ctrl + F and
the Print command is the normal Word shortcut Ctrl + P.

Editing

The Word ¥? UNDO command is available with its
multiple levels. Redo is available from the Edit menu.

Tip: The keyboard shortcuts for Undo and Redo are the
normal Word shortcuts Ctrl + Z and Ctrl +Y.

The Word 4 Cur, copy and 2 PastE
commands work as usual. They are useful for
moving sections within or between documents.

Tip: The keyboard shortcuts for Cut, Copy and Paste are
the normal Word shortcuts Ctrl + X, Ctrl + C, and Ctrl + V.
Interactive Dragging and Dropping can also be used.

Moving

Being able to quickly move through your notes to
locate relevant sections of your document is very
important and one of Factotum’s strong points.

The *= PRreEvious TAG and =* NexT TAG commands
take you instantly to the next or previous example of
the current tag. For example if you are in a quote
tag, clicking on the Next Tag command will take you
to the next paragraph marked as a quote. Text tags
take precedence over paragraph tags so if your
cursor is within an agent text tag within a quote
clicking on the Next Tag command will take you to

Page 8



the next agent. For example to move through this
document command by command (which are tagged
as concepts) position the cursor within one and then
use the Next Tag command. If there is no other
similar tag the cursor will not move. The search
automatically cycles so that if the current tag is the
last in the document you will be taken to the first.

Tip: The keyboard shortcuts for the Previous and Next Tag
commands are Alt + Ctrl + the left and right cursor keys.

The ® PREvious INSTANCE and ¥ NEXT INSTANCE
command take you instantly to the next or previous
instance of the current word (or first word of a
selection). If there is no other instance the cursor will
not move. The search automatically cycles so that if
the current instance is the last in the document you
will be taken to the first.

Tip: The keyboard shortcuts for the Previous Instance and
Next Instance commands are Alt + Ctrl + the up and down
cursor keys.

The # PRrevious HEADING and ™* NEXT HEADING
commands take you instantly to the next heading in
the document. In the Editing Window the commands
will take you to the heading whatever its level, in the
Outline Window the command will only take you to
an equal or higher level heading. The search does
not cycle when it reaches the bottom or top of the
document. If the text contains a lot of text or tables,
the search may take some time.

Tip: The keyboard shortcuts for the Previous Heading and
Next Heading commands are Alt + Ctrl + PgUp and PgDn.

Searching

The &2 SEARCH command calls up a dialog box from
where you can search for any previously tagged
feature or for marked text. The dialog box is
persistent which means that it stays on screen until
you exit from it. This means that it can be used to
cycle through your notes, for example only looking at
key figures or quotes containing the word “love”.

Tip: The keyboard shortcut for calling up the Search dialog
box is Alt + Ctrl + S.

Within the dialog box, you click on the type of tag
you want to search for, enter any Find text to narrow
the search, and then click on Next or Previous to
determine the direction of searching. When found
you can Exit to edit the text, click on Mark to mark
the paragraph, or Unmark to remove marking or
continue searching. For more complicated searches
you can click on the desired tag, enter any text and
then select Advanced. This will call up the Word Find
dialog where you can refine your search by selecting
pattern matching, replacement text etc.

Tip: Within the dialog box all commands are available with
keyboard shortcuts so that for example typing 3 will select
the heading tag 3, or C will select the concept tag, N will
take you to the next matching tag, P to the previous, M will
mark it, U unmark it, E will allow the entering of text to
find , V will enable advanced fine tuning of the search and
X will exit the dialog to allow editing.
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Marked Commands

The [*¥ CoLLECT MARKED command is used to
collect all marked paragraphs into a new location
from wherever they are in a document. For example
if you decide that various paragraphs would be better
in their own section, first mark them with the Mark
command, then go to the new location, and then
select the Collect Marked command. As this is a
powerful command, Factotum asks whether you are
sure of what you are doing, before proceeding.

Tip: The keyboard shortcut for the Kollect Marked
command is Alt + Ctrl + K.

The 5% MARK AND EXPORT command is used to
export relevant information out of your notes.
Selecting it calls up a dialog box for creating a new
file based on marked paragraphs. This will typically
be used for one of two purposes: either to create a
crib or handout file, for example only including major
headings and quotes, or alternatively to copy all
paragraphs relevant to a new project into a new file
ready for processing into an essay or report.

Exporting is a two stage process of first marking all
relevant paragraphs and then filtering them into a
new file. For crib/handout files this can all be done
from within the Mark and Export dialog box where
the different heading and paragraph tags can be
automatically marked and then the Export command
used to create the new file. For essay files it is
usually better to mark the relevant sections and
paragraphs before calling up the dialog box. This can
either be done interactively (using the Outline
Window to mark sections) or with the Search dialog
box with its keyboard shortcuts.

Tip: The keyboard shortcut for calling up the Mark and
Export dialog box is Alt + Ctrl +X.

Arranging Windows

The ] ArrANGE WiNDOWs command is used for
restoring the normal Factotum double screen
arrangement. For example if you select one of the
windows from a list of multiple open files under the
Window menu only that window will be brought to the
front but selecting Arrange Windows  will
automatically restore the normal double view of both
windows.

Tip: The keyboard shortcut for the Arrange Windows
command is Alt + Ctrl + W.

Minimizing either the Outline or Editing Window of a
Factotum file automatically minimizes both windows.
Double clicking on either iconized window of a
Factotum file automatically restores both windows.

The I SpLIT Winbow ToGeLE command is used to
toggle between normal display and a split view of
both Outline and Editing Windows. (A toggle
command alternates between two or more states
each time you select it). The current section of your
notes can then be changed in any of the four
windows using the scroll bar or navigation keys.
Most usefully, different sections of your notes can be
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called up simultaneously in the two Editing Window
panes using the two corresponding Outline Window
panes with the Jump Windows and Synchronise
Windows commands (see below).

This can be used for two main purposes. Firstly it
allows you to keep your current position in the top
window while you temporarily move to another
section in the lower window. More powerfully when
two different sections have been called up, text can
be cut and pasted between the two or even dragged
and dropped.

Tip: The keyboard shortcut for the Split Window Toggle
command is Alt + Ctrl + L.

If more than one Factotum file is open the e
ARRANGE ALL WiNDows will arrange them ready for
copying information between files. The current file
will be arranged in a double window arrangement at
the top of your screen, and all other files in a similar
arrangement at the bottom. Minimizing either of the
bottom windows will cycle you through your open
files until both desired documents are visible.

Tip: The keyboard shortcut for the Arrange All Windows
command is Alt + Ctrl + R.

Changing Views

The lE SHOW/HIDE TOGGLE command is used for
showing or hiding hidden text and the space, tab,
and carriage return symbols.

The B0 views ToeceLe command is used for
changing the Editing Window’s view between Normal
and then Page Layout full width and then Page
Layout full page view.

Tip: The keyboard shortcut for the Views Toggle command
is Alt + Ctrl + V.

The View menu’s commands are also available for
changing either the Outline or Editing Window’s view
though normally this will be unnecessary. Master
Document View can also be called up in the Outline
Window for adding subdocuments etc.

Tip: The keyboard shortcuts for the Qutline, Normal and
Page View commands are Alt + Ctrl + O, N and P
respectively.

Occasionally as you work, you might prefer to

temporarily return to the basic Word set-up. The
ENVIRONMENT TOGGLE command toggles between
Word’s usual single screen and toolbars and
Factotum’s enhanced double screen and toolbars.
However as Factotum has been especially designed
to have as little impact as possible on the workings
of Word 6 this command is really only offered as a
safety blanket and to reinforce the point that you lose
nothing by working under the Factotum set-up.

Tip: The keyboard shortcut for the Environment Toggle
command is Alt + Ctrl + End.

Factotum 1.1 for Microsoft Word 6 (Unregistered)

THE OUTLINING TOOLBAR

The OUTLINING TOOLBAR only becomes visible when
the cursor is within the Outline Window. As
mentioned earlier the Outline Window should be
seen as an on screen table of contents. The
Outlining Toolbar offers commands for controlling the
depth of view, navigation and restructuring.

Tip: It is possible to access the depth of view, jumping and
synchronising commands even when you are working in
the Editing Window by using the keyboard shortcuts as
described below. Alternatively you can move to the
Outlining Window with the Alt + Ctrl + Home shortcut.

Depth of View

The four numbered command 1 2 '3 4 suow
HEADING 1, 2, 3, 4 are used for changing the depth of
view of the hierarchy of your document. These
correspond to the four heading tags of major
division, major section, section and sub section. By
clicking on the commands marked 1-4 the level of
depth shown is correspondingly changed.

Tip: The keyboard shortcuts for the Show Heading 1, 2, 3,
4 commands are Alt + Ctrl + the numbers 1, 2, 3, 4 on the
numeric keypad. For notebook users there are the
alternative shortcuts Alt + Ctrl + #, followed by the normal
keyboard numbers 1, 2, 3 and 4. These commands can
also be used from the Editing Window.

The depth of the view also has an effect on
reordering and marking as both of these commands
work not just on the current heading, but on the
entire section between this and the next visible
heading. For example to mark a major division, first
reduce the depth of view by clicking on Show
Heading 1, then move your cursor into the desired
heading and then click on the Mark command.

The % ExpAND command is used to progressively
show the lower levels of the current section. If only
the major division headings are visible, clicking on
the command will show all subsequent major
sections, then all sections, then all sub sections and
finally all the first lines of all your paragraphs for that
division only. It is best used as a way of honing in on
a paragraph to then call up in the Editing Window. It
also allows individual paragraphs to be reordered
with the Move Up and Move Down commands by
showing their first lines.

The = CoLLAPSE command works in the opposite
way, progressively hiding the lowest levels of subtext
of a selection.

Tip: The keyboard shortcuts for the Expand and Collapse
commands are Alt + Ctrl + the + and - symbols on the
numeric keypad. For notebook users there are alternative
shortcuts Alt + Ctrl + ] and Alt + Ctrl + [ respectively. These
commands can also be used from the Editing Window and
can be usefully combined with the depth of view shortcuts
for example first showing only major divisions and then
expanding the current selection’s headings.
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Navigation

The most useful function of the Outline Window is as
a navigation tool. By clicking on one of the headings
and then clicking on the = Jump WINDOWS
command, the associated text of the heading is
immediately called up in the Editing Window ready
for editing.

Tip: The keyboard shortcut for the Jump Windows
command is Alt + Ctrl + J or, because it will be used so
often, Alt + Ctrl + Space. Jumping will normally be done
from the Outline Window, but the shortcut can also be
used from the Editing Window where it takes you to the
current text’s heading in the Outline Window.

Sometimes you will want to see the full text in the
Editing Window, but not leave the Outline Window
for example to check that it is the section you think it
is before going to edit it. The #  SYNCHRONISE
WIiNDows command ensures that the same section is
selected in both the Outline and Editing Windows.

Tip: The keyboard shortcut for the Synchronise Windows
command is Alt + Ctrl + Y or, because it will be used so
often, Alt + Ctrl + Enter. Using the shortcuts, synchronising
can also be done from the Editing Window where it calls
up and highlights the current heading tag in the Outline
Window before returning the text cursor ready for editing.

Restructuring

The order of the entire document can easily be

changed using the # Move Up and #* Move Down
commands in the Outlining Toolbar. Again the effect
of Moving Up and Moving Down depends on the
depth of view as all text between the current heading
tag and the next heading tag is moved. For example
if you want to swap the order of two entire major
sections choose the Show Heading 2 command and
then click on the Move Down command with your
cursor in the higher heading or the Move Up
command with your cursor in the lower heading.

Tip: To reorder normal paragraphs, they — or rather their
first lines — can be shown in the Outline Window with the
Expand command. Alternatively with the cursor in the
Outline Window you can select the Environment Toggle
(or Alt + Ctrl + End keyboard shortcut) to get an outline
view of your whole notes.

To change the level of a single heading the Heading
Tag commands on the Tagging Toolbar can be used.
To change the levels simultaneously for a whole

section of your notes use the ® PROMOTE or #
DEMOTE commands on the Outlining Toolbar. The
effect of promoting and demoting depends on the
depth of view. For example if only major divisions are
shown, demoting one will affect all its subsequent
lower headings turning major sections into sections,
sections into sub sections etc.

Tip: The restructuring commands are very powerful and
dependent on the current depth of view in the Outline
Window so there are no keyboard shortcuts.
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FACTOTUM IN PRACTICE

Below are examples of the major steps involved in
using Factotum to help in the entry, ordering and
retrieval of your information.

Entering Information

Creating and Opening Factotum Files

To create a new Factotum file from a normal Word
session you must choose the File Menu’s New
command and then select the “Facto1” template to
base it on. A blank Factotum file together with its
double windows, toolbars and in-built tags is
automatically loaded. Alternatively once a Factotum
file is already loaded, a new Factotum file can be
created by simply clicking on the Factotum toolbar’s
New icon. Once a Factotum file has been saved,
opening it from any Word session automatically
restores the double window environment, toolbars
etc.

Taking and Tagging Notes

To start taking notes it is simply a matter of
beginning to type in the Editing Window. As you take
notes it will be obvious that certain paragraphs are
different from others. You should TAG these
paragraphs as you type with the commands on the
Tagging Toolbar. For example a paragraph you want
to stress should be marked with the Nota Bene
Paragraph Tag (5); direct quotes should be tagged
with the Quote tag (6); a series of paragraph points
should be tagged with the List Iltem tag (7); any
other feature that occurs repeatedly — for example
descriptions of experiments — should be marked with
the Standalone tag (8); and any inspired notion or
note to yourself should be marked with the Memo
tag (9). As you tag the paragraph, Factotum
automatically applies appropriate formatting (eg
indented margins for quotes, automatic numbering
for list items).

For the who, where, what, when, why and how
features within paragraphs the text tags should be
used. For example when you mention a key figure or
an author you should mark the name with the Agent
Text Tag (A), an important publication with the Book
tag (B), a key term with the Concept tag (C), a date
with the Date tag and a key example or explanation
with the Example tag. All these uses are flexible and
should be tailored for your own use, for example in
this file commands are marked as concepts. To
remove a text tag use the Normal Text Tag (2).

Tip: The keyboard shortcuts for tagging are simply the
combination of Alt + Ctrl + the number or letter on the
relevant command'’s icon.
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Creating and Viewing A Structure

Lists of notes are of little use without some structure.
The hierarchy of information is created with the four
heading tags. Titles to the fundamental sections of
your notes should be marked with the Major
Division Heading Tag (1) and subordinate sections
with the Heading Tags 2, 3 and 4. Tagging headings
is particularly important as these automatically
appear in the Outline Window.

With the Outline Window the heading tags can be
used for navigating, structuring and exporting your
information (see below). The depth of view can be
changed with the Show Heading 1-4 commands in
the Outlining Toolbar. For example if you know the
section you are looking for is an important one you
can first look only at major divisions (by clicking on
the Show Heading 1 command), then include major
sections (Show Heading 2) etc. If you know the
section must be subordinate to the current heading
tag, you can progressively show lower headings with
the Expand command. After the four heading tags,
the Expand command will show the first few words of
the first lines of each of your normal paragraphs. To
hide subsequent headings and first lines use the
Collapse command.

Navigating

To move to a previously created section to enter or
edit notes you can scroll through the document in the
Editing Window or use the keyboard shortcuts just as
you would in a normal Word session. Alternatively,
and much more easily, you can make use of the
Outline Window. You can click on the heading of the
section you want to go to and then click on the Jump
Windows command to instantly jump to the Editing
Window at the desired section.

Tip: The keyboard shortcut Alt + Ctrl + J can be used to
Jump Windows from either the Editing or Outline Window.
Because it is such a common function there is an
alternative shortcut Alt + Ctrl + Space.

If you want to check that this is the section you want
to see without leaving the Outline Window use the
Synchronise Windows command. This ensures
that the same sections are selected in both the
Outline and Editing Window.

Tip: You can also use the Synchronise Windows
command’s keyboard shortcut Alt + Ctrl + Y from the
Editing Window to synchronise the two windows and to
remind yourself of your current position in the document
structure. Because it is such a common function there is
an alternative shortcut Alt + Ctrl + Enter.

If you only want to move to another section of your
notes temporarily, you can combine the use of the
Jump Windows command with the Split Window
Toggle command from the Factotum Toolbar.

Tip: The keyboard shortcut for the Split Window Toggle
command is Alt + Ctrl + L.
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Ordering Information

At some point you will almost certainly wish that you
had your notes arranged differently, so that, for
example, all your ideas on Mansfield Park are in their
own section rather than scattered throughout your
notes, or that your ideas on Austen’s novels are split
into early and late periods. Factotum offers all the
tools necessary for moving, collecting, reordering,
restructuring and importing your notes at any time.

Moving Notes

Often when taking notes you will decide that the
current paragraph(s) would be better in a different
section. This can easily be done by combining the
Factotum Toolbar's Cut, Copy and Paste
commands and the navigational use of the Outline
Window. For example to move this paragraph to a
different section, you would select it, Cut it, select the
desired new section in the Outline Window, click on
the Jump Windows command, move to the exact
position you want and Paste the text.

Tip: The keyboard shortcuts for the Cut, Copy and Paste
commands are Ctrl + X, C and V.

Alternatively you can use the Split Window Toggle
command on the Factotum Toolbar together with the
Outline  Window’s Jump and  Synchronise
commands. This enables you to call up both the
source section and destination section
simultaneously in the two panes of the Editing
Window. You can then cut and paste or even drag
and drop between the two panes.

Tip: The keyboard shortcut for the Split Window Toggle
command is Alt + Ctrl + L.

Collecting Notes

When there are various paragraphs scattered
throughout your notes that you decide would be
better suited in their own section elsewhere, you
could cut and paste each one, but Factotum has its
own method for bringing them together. First you
mark each of the paragraphs with the Mark
command (indicated by overscoring). You then
create a new paragraph in the desired position and
click on the Collect Marked command on the
Factotum Toolbar to bring all the marked paragraphs
into the new section. Because the process can make
major changes to your notes, Factotum will check
that you want to proceed and save a copy of your file
before collecting.

Tip: The keyboard shortcut for the Kollect Marked
command is Alt + Ctrl + K.

Reordering and Restructuring

Often you will want to move not just the odd
paragraph, but entire sections. This is most easily
done with the Outline Window. By selecting one of
the headings you automatically select all the text
between it and the next visible heading (ie the
section to be moved is affected by the current depth
of view). By clicking on the Move Up and Move
Down commands in the Outlining Toolbar the entire
section can be easily moved up and down the
document order. For example if you want to swap
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the order of two Sections choose the Show Heading
3 command and then click on the Move Down
command with your cursor in the higher heading or
the Move Up command with your cursor in the lower.

Alternatively you might decide that sections you had
thought were important are less so, while others
need to be emphasised. Often this is a simple job of
changing the heading tag. To have a knock-on effect
and change all the subsequent headings for a
section the Promote and Demote commands on the
Outlining Toolbar are used. Their effect depends on
the current depth of view. For example if major
sections are shown (level 2), demoting one will affect
all of its connected lower headings turning sections
into sub sections etc.

Working With Multiple Files

Often you will want to work with more than one set of
notes. If you open both Factotum files and other files
simultaneously, the normal Standard and Formatting
toolbars will not be available for your non Factotum
files (unless you use the Environment Toggle
command to return to a basic Word environment).
For seamless integration of Factotum and other files
you must register / upgrade.

To convert previously created files to Factotum files
apply the Facto1.dot template with the Attach option
under the Templates command under the File menu,
then close the file and reopen it.

You can have multiple Factotum files open at a time,
each of which will have its own Outline and Editing
Windows. You can swap between these windows
with the list under the Window menu. Selecting the
Arrange Window command from the Factotum
Toolbar will ensure that both windows of the same
file are visible. Using the Minimize command on
either window of a Factotum file will minimize both,
and double clicking on either window of an iconized
Factotum file will restore both.

Tip: If the obscured Factotum file you want to work on
features on the list of file names under the File menu,
clicking on it will bring both its windows to the front.

To be able to cut and paste between multiple files it
is useful to be able to see them both simultaneously.
This is achieved with the Arrange All Windows
command on the Factotum Toolbar. The current
document’s two windows are arranged at the top of
the screen and all other Factotum files are arranged
at the bottom of the screen. If you have more than
two Factotum files open and the bottom document is
not the desired one you should minimize it. When the
right files are visible, the desired sections for copying
between can be called up in the two Editing
Windows using the Jump or Synchronise commands
in the two Outline Windows.

Tip: The keyboard shortcut for the Arrange All Windows
command is Alt + Ctrl + R.
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Retrieving Information

The information in your notes only becomes useful
when it is retrieved. If you simply word-process your
notes, when you try and use them often months even
years later, once you load up the file you are
essentially left to your own devices. The only option
for finding the information you are interested in is to
scroll through the document or hope you can
remember a word to search for. With a Factotum file
you are in a much better position. To begin with you
are instantly shown a table of contents style view of
the document in the Outline Window. More
importantly if you have used the in-built Factotum
tags you have a range of commands for moving and
searching and exporting.

Instant Moves

Factotum has six commands on the Factotum
Toolbar for manoeuvring through your notes,
instantly moving to different sections of your
document. The Previous Tag and Next Tag
commands are used to move to the next or previous
example of the current paragraph or text tag. This is
useful for example for cycling through all the quotes
in your document or moving from book tag to book
tag.

Tip: The keyboard shortcuts for the Previous and Next Tag
are Alt + Ctrl + the left and right cursor keys.

The Previous Instance and Next Instance
commands move you to the next or previous
instance of the current word. For example if you are
reading or writing a section about Freud, with your
cursor in his name you can click on the Next
Instance command to go to the next reference to
him.

Tip: The keyboard shortcuts for the Previous and Next

Instance commands are Alt + Ctrl + the up and down
cursor keys.

The Previous Heading and Next Heading
commands move you to the next or previous heading
tag and are an excellent way of scrolling through
your document. In the Editing Window the
commands will take you to the heading whatever its
level, in the Outline Window the command will take
you to an equal or higher level heading.

Tip: The keyboard shortcuts for the Previous and Next
Heading commands are Alt + Ctrl + PgUp and PgDn.
Keyboard commands can be combined so that for
example if you want to move to the next more important
heading from the Editing Window you should use the
commands Alt + Ctrl + Space then Alt + Ctrl + PgDn.

Searching

For more advanced navigating and searching you
can use the special Factotum for Word Search
dialog box by clicking on the Search command.

In the dialog box you can select a tag type and then
click on the Next or Previous commands to cycle
through your document for example only looking at
the nota bene, book or memo tags. Alternatively you
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can enter some text to narrow your search for
example to find only quote tags containing the word
“Love”, or concept tags containing “theory”. For more
advanced searches you can set options and then
use the Advanced command to refine your search
using pattern searching, case matching etc or
entering replacement text.

There is also the option to Mark or Unmark
paragraphs which is useful to cycle through a
document marking text to be brought together with
the Collect Marked command or to be exported with
the Mark and Export commands.

Tip: Within the Search dialog box there are keyboard
shortcuts so that for example typing Alt + Ctrl + S, then C,
then N will automatically call up the Search dialog, select
the concept tag and take you to the next example.

Exporting Information

One of the most common uses of notes is to retrieve
the relevant information within them as the basis for
another document. There are basically two types of
these export files either a base file for example
containing all the sections of your notes relevant to
an essay topic, or a crib file for example containing
all the headings and quotes in your notes.

In both cases, exporting is a two stage process of
first marking all relevant paragraphs and then

Factotum 1.1 for Microsoft Word 6 (Unregistered)

filtering them into a new file. For essay base files the
relevant sections and paragraphs are marked before
calling up the Mark and Export dialog box. This can
be done with the Search dialog box and its keyboard
shortcuts, or interactively with the Mark and Unmark
commands in the Factotum Toolbar. In the Editing
Window marking affects selected paragraphs, in the
Outline Window marking affects the current section
(which depends on the current depth of view).

For crib files marking can be done from within the
Mark and Export dialog box. First select the different
paragraph tags to mark then choose the Mark
command. If you are wanting to export all your notes
apart from some tags, first select All then Mark and
then (after deselecting All) select the tags to Unmark.

When the relevant paragraphs have been tagged for
either base or crib files select the Export command.
Factotum will check that you want to proceed, then
save the file, cut all marked paragraphs, restore the
file, open a new file and insert the cut text (it also has
to restore the former paragraph tagging). In long files
the process can take some time.

Tip: Within the Mark and Export dialog box there are
keyboard shortcuts so that for example typing Alt + Ctrl +
X, then 1, then 6, then M, then E will automatically call up
the Export dialog, select the major division and quote tags,
mark them throughout a document and then export them
to a new file.
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FACTOTUM 1.1 FOR WORD SHORTCUTS

Factotum for Word has a complete and easy to remember system of keyboard shortcuts corresponding to each of
its commands. Each shortcut is based on a combination of the Alt + Ctrl keys together with one or two other keys.

SHORTCUT COMMAND

Alt+Ctrl+A

Alt+Ctrl+B

Alt+Ctrl+C

Alt+Ctrl+D

Alt+Ctrl+E

Alt+Ctrl+F

Alt+Ctrl+G

Alt+Ctrl+H

Alt+Ctrl+l

Alt+Ctrl+J

Alt+Ctri+K

Alt+Ctrl+L

Alt+Ctrl+M

Alt+Ctrl+N

Alt+Ctrl+O

Alt+Ctrl+P

Alt+Ctrl+Q

Alt+CtrI+R

Alt+Ctrl+S

Alt+Ctrl+T

Alt+Ctrl+U

Alt+Ctrl+V

Alt+Ctrl+W

Alt+Ctrl+X

Alt+Ctrl+Y

Alt+Ctrl+Z

Agent Text Tag (who)
Book Text Tag (where)
Concept Text Tag (what)
Date Text Tag (when)
Example Text Tag (how/why)

Copy to Floppy
Upgrade File
Factotum_Help
Factotum Information
Jump Windows
Kollect Marked

Split Window Toggle
Mark

Normal View

Outline View

Page View

Quit File

Arrange All Windows
Search
Register/Upgrade Factotum
Unmark

Views Toggle
Arrange Windows
Mark and Export
Synchronise Window

Normal Text (remove text tags)

SHORTCUT

Alt+Ctrl+1

Alt+Ctrl+2

Alt+Ctrl+3

Alt+Ctrl+4

Alt+Ctrl+5

Alt+Ctrl+6

Alt+Ctrl+7

Alt+Ctrl+8

Alt+Ctrl+9

Alt+Ctrl+0

Alt+Ctrl+<

Alt+Ctrl+—

Alt+Ctrl+

Alt+Ctrl+l

Alt+Ctrl+PgUp

Alt+Ctrl+PgDn

Al+Ct+SPACE

Alt+Ctrl+ENTER

Alt+Ctrl+Home

Alt+Ctrl+End
Alt+Ctrl+#, 1
Alt+Ctrl+#, 2
Alt+Ctrl+#, 3
Alt+Ctrl+#, 4
Alt+Ctri+[

Alt+Ctrl+]

COMMAND

Major Division Heading Tag 1
Major Section Heading Tag 2
Section Heading Tag 3

Sub Section Heading Tag 4

Nota Bene Paragraph Tag 5
Quote Paragraph Tag 6

List Item Paragraph Tag 7
Standalone Paragraph Tag 8
Memo Paragraph Tag 9

Normal Paragraph 0 (remove para
Previous Tag

Next Tag

Previous Instance

Next Instance

Previous Heading

Next Heading

Jump Windows

Synchronise Windows

Swap Outline/Editing Window
Environment Toggle

Show Heading 1  (Alt+Ctrl+Num 1)
Show Heading 2 (Alt+Ctrl+Num 2)
Show Heading 3 (Alt+Ctrl+Num 3)
Show Heading 4 (Alt+Ctrl+Num 4)
Collapse Outline (Alt+Ctrl+Num -)

Expand Outline  (Alt+Ctrl+Num +)
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REGISTRATION / UPGRADE FORM

If after evaluation you continue to use Factotum for Word you must register / upgrade at the cost of £25.00 or
$40.00. If you are a genuine full-time student you are eligible for a £10 or $15 discount on this price if you include
a photocopy of your current matriculation card. On registration you will be sent version 2.1 which offers:

e |IMPROVED DOCUMENTATION

Separate illustrated manual / help and sample files etc
e QUICKER PERFORMANCE

Up to 100% faster on some operations, no nag screens etc
e BETTER INTEGRATION

Open Factotum and ordinary Word files simultaneously with full toolbars etc
e |IMPROVED FUNCTIONALITY

New Writing Aids Toolbar offers the most useful commands for note takers eg word-count, footnotes etc
e CUSTOMISABILITY

File and template formatting can be customised to your own use, avoiding limitation to Arial etc
e BETTER HEALTH

Sleep easier knowing that you are supporting the development of Factotum and will hear of any future versions(!)

FACTOTUM 2.1 REGISTRATION / UPGRADE FORM

| would like to register and upgrade to version 2.1 of Factotum for Microsoft Word

Name
Address
City Country
Post Code (E-Mail Address)
| enclose a cheque made out to Online Design for £25.00 or $40.00 inc. VAT
(or cheque for £15.00 or $25.00 and a photocopy of current matriculation card)
Signature Date

How did you find out about Factotum?

Any comments (problems / wish list)

(please continue overleaf)

Please return form and payment to Online Design (Software),
Greenside House, 25 Greenside Place, Edinburgh, UK, EH1 3AA.
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